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Okay, | believe we are recording now. It is Wednesday, March second, it's about 5 minutes after 11. So we're
getting started a few minutes after the hour. And I'd like to say hello to everybody. It's been a very busy time.
I've been trying to let you know a little bit about what's going on. I'll tell you briefly. The Best Practices Course
is going to expand in a very nice way. | had interest from many of the ArchiCAD resellers and distributors from
around the world to be able to share the course with their clients. So I've launched a campaign, which is about
to climax with the reopening of registration for the course. [:57]

This has reached actually thousands of people around the world in the last few weeks, and tomorrow we'll be
reopening the doors for registration. I'm not sure how many people will come in, I'll keep it open for seven
days. That will allow time for those who are interested, but give some motivation for people to make a
decision sooner rather than later, as you all experienced in November and December, when | did have the
previous opening. By having it open for only a limited period of time, it makes you think, "Do | want to do this
or not?" And makes harder to say, "Well, I'll think about it later", and come back later. [1:44]

So in any event, I'm hoping that we have quite a few people join in. And it really shouldn't dilute, or minimize,
or reduce your experience. In fact, part of what I'm going to be doing with the expanded membership of the
course is offering some additional content, which of course | will offer to all of you as well. The people who are
joining this time will actually be paying a little bit more than you did, we're looking at $497 instead of $397.
Although there may be some exceptions for some places like Africa, where people - it looks like | may need to
do some type of coupon that will allow them to get in a little bit less. [2:30]

But in general, people will be paying a little bit more, and I'm going to be adding a little bit more to the course.
And I've already described it by email, so | won't be going into it in any detail. But | will add, | will be
announcing partway through this registration that I'm going to be adding a Quick Start series of modules.
These are intended for the newer users of ArchiCAD who need additional assistance. Just getting started,
knowing how to set up their screen, how to navigate around, how to draw a wall the right length, some of the
basic things. [3:07]

And | know that some of you who signed up for the course already are in that position, because you are newer
users. And even those people who have been around for awhile, | imagine that they'll be things that | will
explain in this series of modules that you'll find useful. Things that you maybe aren't aware of in terms of even
doing some basic things. Just because when you started three, four, five, ten years ago, some of those features
weren't available, or you didn't learn them, and you've gotten by without them. So in any event, the Quickstart
module will be | believe a series of six weeks of content, which will be parallel or to the side of the main course.
[3:50]

And it is possible that | may turn that into something that | sell separately, but right now it's going to be rolled
in as a bonus for the Best Practices Course. In addition, I'm also looking probably at creating a separate or
second coaching call, structured a little differently than this one. | think it may be a more extended one,
perhaps 3 hours. Also once a month, so basically there will be two opportunities for me to interact with you
directly. And the one difference I'm looking at is possibly having people, we're calling it "Office Hours", and
having people pick a number, so to speak, and ask their question and get the answer. And some questions may
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only takes 5 minutes, some may take 20. But sort of go in sequence. I'll broadcast it so that everyone could
potentially watch it, but you could also take a number and say, come back and an hour or something like that,
and know that you've got a time reserved. [4:57]

Obviously, | can't take everybody's call or question during that session, but | think we'll be able to address
more, just by having more hours there. Anyway, I'm looking at ways of setting that up logistically that would
be most useful. And of course it will still be recorded, so you would be able to watch it later. One of the issues
of that of course is that you can't necessarily watch 3 hours of miscellaneous questions, but perhaps I'll be able
to do some type of indexing or table of contents where you'll be able to scan what questions were asked, at
least a brief description, and say, "Oh, that question that's about an hour and a quarter into it, that looks pretty
interesting." So you could watch that. [5:40]

So I'd like to improve and increase the services that I'm offering to you. And by having more people, I'll be able
to focus on this, and not have to continually be marketing things. I'll be able to just focus on creating the
content and serving you there. So that's a little bit of an update in terms of the new components that will be
part of the Best Practices Course, that you'll all be receiving without any extra charge. And if you do have
friends or colleagues that you think the course would help, then please refer them. Tell them to go to
ABCbestpractices.com. If they go now, there will be an opportunity to see some of the free tutorials that |
posted. And starting tomorrow-in fact, about 25 hours from now, at noon California time, is when I'm
targeting, I'll open the doors for signup for about seven days. [6:43]

So | appreciate and referrals, because | think that you can share some good things with your friends. So getting
starting now with the coaching call, | know everything is being recorded, at least - let's double check here, on
my secondary machine, if it's indicates that its being recorded properly. Yes, itis. At least it saysitis, so - let's
see, how do | minimize this there. Okay. So it is being recorded for posterity so to speak. Okay, in terms of
questions, there were only a couple of questions that were submitted in the last couple of days that certainly |
can address those. There were a number of questions from one of our members, David Olufs, a little while ago,
| guess a week or so ago, and | promised him that | would address some of those. [7:54]

I'm going to try to bring up the emails, so that | can look at those - | wonder if David is on the line. David, if
you're on the line - let's see, | can see the attendee list here. No, actually | don't see Dave listed, although there
are people who are still alive in here. In any event, because | only have those two questions, and the ones from
David, | am definitely open to your additional questions. So you can type them into the questions panel. Okay,
| see, from John Chando, why, in ArchiCAD 14, have they taken away File, Close? Oh, interesting question. |
don't know. That's a quick question. And let's just discuss that a little bit. [8:54]

Because I've reconfigured the - let me just set my work environment, so it's set up a little bit better here for my
palettes. So now, I've just reconfigured my palette quickly to be able to see things a little bit better for our
purposes. So let's say that | have a sheet open here. And so I've got now a window that is not my floor plan
window, and you'll notice the Close box is available here, and also under the File menu. Actually no, they don't
have Close available there. Okay, so they've taken it out. | think it may be actually a little different on
Windows side, I'm not sure. But certainly when you want to close individual windows, you can close it here.
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[10:06]

Now if | close, most of you will be aware that if you close the floor plan, you actually close the project. Under
the File menu, it doesn't actually say Close Project. | know I've seen that. Maybe that was in 13, and then they
took it out entirely. It's a good question, why they have taken it out of that. So just a few comments. This has
changed obviously, it was something that was available before. | think what they wanted to do was prevent
people from accidentally closing the project out without realizing it, because it's very common to just click on
"Close Windows", or go to the File menu and close, or hit the shortcut. and sometimes people didn't realize
that if they close the floor plan, that they actually close the project. [11:02]

So if | actually click this and close it, then you can see that ArchiCAD doesn't go away. In other words, it didn't
quit ArchiCAD, but it now has no project open. I'm going to go and again create a new file. So | don't have any
big insight into that, but just know that there will always be a Close button that you can use. And interesting,
we can take a look. I'll just take a quick look, once this reopens, at the Menu commands. The Options menu,
Work Environment. Not all of you may be aware that in the menus, you can actually add and take away menu
commands or actually organize your own menu. | just went to the Options menu, work environment, and
there's a section for menus. [12:03]

Now here you can see in the File menu, if | double click on File, these are the commands that are currently
showing in the File menu. And here you can see Current Menu Structure, and this will actually imitate exactly.
So whatever we see here will be over on the other side. However, we can switch from looking at just what's in
the current menu to look at all commands in alphabetical order. And when we do that, this includes
everything, even the things that are not in the menus. [12:41]

So for example, close window or close project are not in the menus, and could be added. And you notice here,
this "Closes the Project" is a new command in ArchiCAD 14. So this isa command - in fact, I'm wondering
whether my menu commands in 14 here are even the standard menu commands. That would be something
that | could also check. But if | did want to add Close Project here, | would say "Add, Select". And you can see
how it shows up on the right side under the File menu. And when | drag it by moving my mouse over the up
and down arrows, | can bring this up until | get to where | want. So for example, I'll put it below the open
command. And let me just take the Close Window one and drag that across. Now | have Close Project and
Close Window added, and | say OK. You'll see now under the File menu it says Close Project and Close Window
are two options that have been added. [13:46]

So the longer answer is that they've actually tried to differentiate between closing a window, such as the 3D
window, or a layout sheet or an elevation, and closing the project. And the menu commands may be set up to
take advantage of that. If | go to the Options, Work Environment, again to menus here, you'll see that the
command layout switched they are overall. If | go to Standard Commands 14 here, this is a scheme that will,
when | apply it, bring it up to the standard that Graphisoft sends out to everybody. When | do that, and confirm
this, the menus will go back to the way they are when ArchiCAD ships. [14:37]

And in fact, actually here, Close Project is now available. So my menus, a minute ago, had Close Project and



Best-Practices-Coaching-Call-March-2-2011

Close Window, because | manually did that. And before that, didn't even have the close command. So | think
what happened is the ArchiCAD 13 commands were still being used, they were inherited perhaps from my
previous setup. So | hope that's clear enough. These menus can be adjusted to see your needs. And they did
add some more sophistication with the close command. And so now there is a difference between closing an
individual window and closing a project. [15:15]

So, | don't see any other questions having been typed in, but please go ahead and add them as you see fit. |
will take a couple of questions that were - actually, I'll bring them screen as soon as | can locate them. Let's

see, we have one from the Lennox Archibald. Is Lennox in a meeting right now? Yes Lennox you're there. I'm

going to unmute you. So Lennox are you there?
Lennox: Yes | am.

Eric: Hello Lennox?

Lennox: Yes, | am.

Eric: Excellent. Lennox | believe you're in Grenada?
Lennox: Yes | am.

Eric: So you're asking a question about brick facing on top of a CMU wall. Let me just see if | can get this over
onto the screen. I'm running Windows using parallels on my Mac, and I'm now going to be bringing over an
Outlook window here for your question. Let me bring that up there. So when you asked about using a brick
facing on top of a CMU wall, which falls in irregular shape and extends between two stories. And you
mentioned that they have different finishes, and how can you shape the brick facing, or remove the brick facing
from the areas where it's not needed. So what I'm understanding here is that you have a complex wall with
more than one surface material. It's not necessarily all in the same plane, if you are talking about shaping it or
removing things. And definitely you want to be able to do different materials. So the CMU | assume is some
type of concrete or paint on the concrete and then brick separate from that, is that correct? [17:21]

Lennox: That is correct.

Eric: Okay. So this involves - let me just now demonstrate a couple of things about complex profiles. So if | go
to the wall tool, and I'll just draw a box of walls to get started. And then we'll take a 3D view. Alright, so these
walls obviously are just very simple. | can go to any wall here and change it from - if | scroll over in the info
box, | can change it from a straight wall to a tilted wall, or a wall with two sides actually being at different
angles. And | can also choose a complex profile. So when | choose a complex profile, initially it doesn't look
any different because it will just copy the profile in. In this case just a rectangular extrusion. [18:15]

But now this option is available, and | can make a different profile. So these of the profiles in the standard
template. You can see here's one with brick wall with molding and footing, here's a foundation wall, and then
there's a different type of precast. Now, let me just pick the brick wall with molding and footing, and we'll see
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this change. Now, not seeing much difference, because it's actually - Oh there. It just took a minute. It changed
its height, it also changed its material. We can see the brick. And if | rotate around here and zoom in, you'll see
that this wall now actually has multiple materials as well as a more complex shape. So let's take a brief look at

how this is defined, and a look at your question. [19:08]

So if | go to the Design menu, Complex Profiles, Profile Manager, we'll see the Profile Manager shows a little
control box, and allows me to choose from different profiles that I'd like to work on. Now you'll notice that
there's a fairly long list, maybe a dozen or 15 different ones, but only three of them have this little symbol that
they're for the wall tool. So those are the three that we'd seen earlier, and you can see when | highlight them.
Other ones, like these sections, are for structural steel. They would be used for beams or columns. And this is
a preference when you create a shape. [19:49]

So let me take the brick wall with molding and footing, and we'll take a look at it. So it brings this up here with
a little preview. And when I click on edit, it shows in profile. We'll see the profile comes up on screen. Now,
what we're seeing is something that does look similar to what we saw in the 3D window. And | want to point
out some of the components of it. When I click in the central area, you'll see that it selects the main vertical
section of wall. Which it says is a fill. And notices little popup indicating I'm not selecting a wall, I'm selecting a
fill. So in fact, the profile is defined by a series of fills that create solid volumes. This particular solid on this
particular fill says that its of a certain type, and in fact if | look in the components, basically this is like your info
box but specifically for the Profile Manager. It says that the side materials of this are custom edges. In other
words, that means that they are not uniform. And as you may recall, when we're looking at the outside of the
building this wall was brick, and the inside of the wall was painted a different color. [21:02]

Now, if | select this piece, you'll see that it again is a fill that has side materials. In this case, it says it's uniform.
Its a certain paint color. “Paint-02 Whitewash”. And if you look behind this particular window, you can see if |
look at my cursor, you can see that it - you are seeing my cursor there. You'll see that that's a light color.
[21:26]

And if | select this lower down one, you can see it says "Custom Edge Included". This one is more complex. So
what does it mean to have a Custom Edge included? Let me select the main wall here. So when | go to the
edge of this fill and press down, you'll see that there are standard editing controls. For example, | could make
it thicker or thinner, or | coule do some other things, including curving the edge here. But unique to the
complex profiles, or at least different than many polygon editing, is this option at the end here which will say,
"This edge is Custom". Or I'm about to make it custom. And it says what material do you want? [22:14]

So here's the setting on the side, it says it's only on the selected edge. Or at least I'm only modifying or setting
the selected edge. If | go to this other one - let me cancel this. If | go to the other side and press down and do
the same choice, then you can see it's a "Paint Grey". So in other words, it's painted grey on this side, and it's a
brick material on the other side. So there we have at least one part of the puzzle explained, which is that you
make a single wall out of multiple components, that each have one or more material designation. Now in
addition, we can differentiate even along what appears to be one surface, by essentially breaking up that
surface. [23:06]
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So what I'm going to do is actually duplicate this. So I'll use the "Duplicate" button here, and now is says
"Custom". And later, or at any point, | can go ahead and say I'd like to store the profile, and we'll just call this,
in your honor Lennox, "Lennox's wall". Okay there you go. So there you go Lennox. Now | don't know what
the shape is, it doesn't really matter too much for this demonstration. | just want to show you, if we were to
take this wall and say it's going to be concrete down below and brick up above, how would | do that? So what |
would do is I'd go anywhere along here, and instead of moving it or changing the edge, | would go and click this
button which would say I'd like to insert a new node. And when | insert a new node, | could make this a very
complex shape. This wall would be - come out, get thicker and then get thinner. [23:59]

But this point doesn't actually have to be outside. It could be at any height. And of course | can measure this.
You can use all the standard coordinate things. | won't bother with it for now. But let's just say the lower area
we want to be concrete, and the upper to be brick. So what I'll do is go here. And now say the lower one,
which would be the one between the two node points, I'm going to change this to be - oh, let's say, where do
we see, if I'm looking for the concrete. There's the sidewalk, but where is - where is concrete? Here is
concrete, let's say light. Okay. On selected edge only. We also have the option to use even change the edge
contour within a section. So in other words, just show it with a thicker or thinner line, or with different colors.
[24:54]

So now, having done that, we'll just save this. Actually I'll store it again. So that means it will be updated. And
now | can go and select any wall. So let me just select this wall. And | am going to tell it to be a complex profile.
And then tell it to be "Lennox's wall". It doesn't look much different. In fact, on the lower side it looks
identical. You can see it matches now. But if | zoom around, you'll see that - it's a little bit dark on the screen.
So let me just bring some sun... Let's say, go to 3D projection settings here. So in the View, 3D mode, 3D
Projection Settings, or the shortcut Shift+Command+F3, or probably Shift+CTRL+F3 on Windows, and I'll just
move the sun around, let's say to be more on that side. And let's say OK. Now it's much brighter. And you can
see the two different materials. So that's how we work with it. [26:02]

Let me go head and edit this just a little further. And if you wanted to make a little bit more complex, and |
really don't know what you want, but hopefully this will answer the question. Let me just say | don't want to
edit this finish, | actually want to add node points. Actually, no what I'm going to do is actually subtract out a
space. So this is the standard boolean operation that is available with any polygon element. Basically allows
me to take the outline, which right now looks rectangular but actually has five points, because of the extra
node that | added. And I'm going to add additional points or let's say modify the outline by removing some
stuff. So, I'll just go ahead and click a series of points down here. And of course | could measure this precisely,
and | can adjust it afterward. [26:55]

But you see that now I've changed the shape of this to have a notch. And in this notch, let me say that I'll go to
the edge here. No sorry, this one. And let me make this a yellow, just so it stands out. And | could do that for
the top and bottom of these, zero, and I'll just do down here. So basically just pointing at each edge and doing
that. Now if | store this, and | go back to the 3D view, you can see that instantly, the wall now has that notch,
and a contrasting color. So, these are some of the options that we can do with complex profiles. | will be doing
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a whole section of the course on complex modeling operations. So there are more things you can do with
these profiles. But hopefully, this will give you enough to do some more of your design. How does that work
for you Lennox? [28:00]

Lennox: Well, it was, | love the information there, that | can use. But what if | want to have the brick piece and
sitting at inverted U shape, where it is low on two sides and high in the middle?

Eric: Okay. Your sound is not really clear, so can you speak a little bit slower, and then it will be easier to
understand?

Lennox: What | am searching to find is to get the brick in an inverted U, low on the two sides, and high in the
middle area, as opposed to one consistent line across.

Eric: Okay, | understand you want to change the shape, and not have a consistent line, but | didn't quite-what
type of shape would this be?

Lennox: A U, an inverted U. An upside down U.

Eric: An upside down U?

Lennox: Yes.

Eric: So this would be sort of rounded at the top?

Lennox: Not necessarily round, it just cuts out the inside.

Eric: So there would be a void or a hole on the inside?

Lennox: The brick would be shaped like an inverted U, and the yellow would be all the remaining section.

Eric: If you had sent me a sketch, | would be able to do precisely. But let me just go back in and say we can
modify this. So if | go and let's say that we, instead of editing this, I'll click cancel. I'm going to subtract out,
and in this case | will subtract out something here. So now there is a void there. And to some extent, it is like
your inverted U. So let me just store this.

Lennox: The inverted U is on the surface, the brick surface.

Eric: The inverted U is on the brick surface?

Lennox: Yes.

Eric: So are you talking about something that would be seen in an elevation view, as sort of an arch?
Lennox: Yes. Elevation View.

Eric: As an arch essentially?
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Lennox: Yes.

Eric: Okay. So then, you won't do that with the profile. But let me just finish this, just so you can see what the
effect would be. We're not going to see much difference here. If | go underneath it, you can see that I've now
got a cavity there. So, and I'll just zoom back out.

Lennox: Yes. When it showed was very...

Eric: Whatever shape we create in the profile will be extruded consistently throughout the shape. Whether its
straight or if you're in ArchiCAD 11 or later, you can actually curve this. You can see that we can get a nice
shape, even in a complex cutout. Underneath, you can see what it's doing. Now your question, let me just get
it back to straight. In terms of the - being able to have an inset into this with a shape, can be done with a
variety of methods. There is an option to use Solid Element Operations, would would be another very, very
important part of ArchiCAD's complex modeling tools. [31:36]

So in terms of Solid Element Operations, the simplest thing - let me just create - let's see, we'll use an object.
Actually no, let's combine this. Alright. I'm going to create a new profile. And, so in the Profile Manager, I've
just said, Create A New Profile. And I'm just going to draw a fill. Let's say that, let me draw this as a box first of
all. And let's say that it is dimensionally 3 foot by 7 foot. So this is sort of like a panel except I'll take this up to
the top of it in a little bit of an arch there. So this is the shape, 3 foot by 7 foot, and it goes up to about 7 1/2 or
8 feet. And this would be 2 meters, 2 and a half meters in height. And what I'll do is I'll just store this as a
profile here, and I'm going to call this an arch or cutaway. So this is now a shape that | can draw with it. [32:47]

So let's go to the floor plan having done that. And let's just zoom in, go to the Wall tool. And I'll say that | want
to create a custom profile here. I'll take the arch or cutaway. Now when | draw this, and | won't draw a box,
because | don't want walls, | just want a single one. So when | draw this, it's real hard to tell what's going on
here, but this is a top down view. And when | go to 3D, let me zoom out and around, you can see the element
is that shape. [33:35]

So I'm going to take this element and denote that its brick on the sides, but the end is a different color. That's
because the fill that | used in creating it was set for the brick. And the ends are set manually for each instance
of this with the Materials palette. Let's see here, let's call it again, I'll just give it a brick, just to be sort of
arbitrary there. So although it looks a little bit odd because of the way the bricks are running, let me not worry
too much about that for this particular quick demonstration. Now what I'm going to do is drag this into the
wall. Now, I'm dragging it to the face of the wall here, and then I'm going to drag it again. And this time, let's
say I'm going to drag it 4 inches in, so | can control the distance. [34:32]

So now it's actually penetrating the wall. And if | go to 3D, it will just stick into the wall. We won't necessarily
know how deep it is. But if we select this wall, you'll see that it's going around that. Now what I'm going to do
is do what's called a Solid Element Operation. So this is under the Design menu, Solid Element Operations.
And in Solid Element Operations, I'm going to say that this wall here is going to be the target, so it's going to be
modified. Then I'll select this new arched element, and make it the operator. And I'm going to do subtraction.
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Now when | subtract, | can leave the original wall, or the wall that is being modified, or the target elements
with their own attributes, meaning that it could remain gray. Or | can inherit the attributes of the operator.
That means, at least in principle, that if this has got brick on it, that the cutaway will have brick. So I'll say
execute. [35:38]

Now, we can't really see the different right now because the brick arch is sitting there. So it's in the way of
seeing the results. But if | select this wall, you'll notice that it does have a cutout. At least it's indicating that
it's being cut around it. Now in order to be able to see the results, | need to put this on another layer and hide
it. If | delete it, the operation goes away. So unfortunately, you can't do a cut and then just delete it to see the
results. But instead what I'll do is I'll go and now put it on a layer. Now the layer here that I'm going to use is a
demo, just because it's conveniently already hidden. Usually we wouldn't put a tool like this - I'm calling it a
tool, but basically this element that is being used as a cutting tool. [36:35]

| would have it on a layer that would not be part of the demo information if this was a remodel project. But I'm
just going to use that, because that layer exists in the standard template and it happens to be hidden right
now. So when | do that, this goes away, and you'll notice that the wall is now cut by this element and has a
different contrasting material. Is that more of what you were thinking about? [37:02]

Lennox: That answers my question. Thank you.

Eric: Now just a brief review of the tools that | used to do this. | demonstrated something that perhaps is not
directly relevant for Lennox, which was how you can set up a complex profile with multiple materials. That was
the profile that | had originally, the brick wall with molding and footing, and then | duplicated it and created a
rather funky looking wall that | named in Lennox's honor so to speak to demonstrate all the different materials.
But this is going to be a simple extrusion that is taken in a straight line, or perhaps a curve. Now to something
that you would see somewhere along the length like this, I'm using a Solid Element Operations which is this
palette, which is available from the Design menu, Solid Element Operations right here. [38:03]

It's gray right now because we already have the palette open, but of course earlier | used that to open up the
palette. So Complex Profiles is the option right above here that we have open, and Solid Element Operations is
the other palette. And actually | created a Complex Profile to create the shape that | wanted to cut out, which
was the arched thing, the arched wall, and then | drew an element like that and then used the Solid Element
Operations to take it as the operator and subtract it from the target, which was the wall. And in this case, to
change the materials of what was being seen there, | used the option to inherit the attributes for the operator
which then sort of impressed the materials as it was cutting away. So this just a very quick recap of the last 20
minutes of demonstration. So Lennox, any last questions before we move on? [39:03]

Lennox: No, that's fine, I'm okay, thank you.

Eric: Okay, then I'm going to mute you, and we'll go onto another question. So | need to look at the other
question that was submitted ahead of time. Let's see, where is it? Okay, so there it is a Edwin Pagaduan, who
asked a question about objects. Here let's see if Edwin, no Edwin is not on the call. At least|don't see him
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logged in. And | do see - so let me defer that. He asked about a - I'll just bring it up onscreen so you see it. |
may be able to return to it. But let me give priority to the people who are on call. [39:59]

He asked for a tutorial on creating GDL objects using alpha channels that rotate and face the camera. So
basically, if you have a view, and you want to have something that faces the camera, why would you want to
do that? Well, sometimes you'll have objects that are actually just cutaways. For example, a picture of a tree,
or a picture of a person that looks quite realistic, as long as it's facing directly on, much like a cutout you might
see at one of those video stores that are going out of business nowadays. Hollywood Stars or something like
that. Basically, you can put in these objects that would look nice in a rendering, to make your presentations
better. [40:49]

It turns out actually - let me just see if | can do this real quickly. | think that this is something | don't have to do
a tutorial on. I just basically have to find the part and we'll see whether it works here. So in the Object tool, if |
go to the Object tool and open it up, I'm going to go and search for an object by name. So I'll use the option
that not everybody knows is available called "Find Library Parts". And I'll go here, it says Keyword, but actually
is a few characters or a word that are part of the name. So it's really not a keyword like plumbing, but it's more
like part of the name. So in this case I'm going to type in "Picture" and I'll say Find. [41:32]

You can see that there is a picture here in the library, and when I click on it, you'll see that it shows just a
simple framed rectangle with what might be a picture. Now by the way, if | wonder where this is located in the
library, | can switch from "Find Library Parts" to "Folder View". And we'll see that it is under "Furnishings",
under the folder called "Art". Now that would be different in different libraries of ArchiCAD, because | have
reorganized this somewhat. And even for the international library, it is definitely - things are quite a bit
organized quite differently. For example, in the U.S. and Canada, we have the CSl standards, which have
numeric folder names. [42:17]

Internationally, that CSl is not let's say a recognized international standard. So Graphisoft has a different
organization into 3D components and 2D components and things like that. In any event, you can to search for
"Picture" and I'm sure you'll find in every version of ArchiCAD. But one of the things is that you can, this is
showing it is a gray, but it will use a ,picture like you can see this little picture of classic, maybe it's a Rembrandt
painting. But you can go, use "Custom Picture", and then you can actually pick a picture. And this would be any
picture that you choose from your library. [42:53]

So you can actually, in the Library Manager, you can load in one or more folder or individual JPEG or TIF files,
and then you would type in the name without the letters .TIF or .JPG at the end. Just the name of it. Now I'll
just leave it with the standard picture which would be this one. Now there is a 3D representation, let's see.
Okay, Tilting, Angles, zero. So this one, | had recalled that there was a one in the library that actually did rotate
to face the camera. So | will think - this does not have that option here. So I'm going to defer this, and just say
this is certainly a useful part as it stands, and it can be modified in terms of its angle, not only rotated on the
plan, but you can, if | type in 45°, it can rotate down, or let's say 0° or something like that, it will sit - lets see,
90°. It will sit flat on the floor, which allows you to do things like carpet. [44:04]
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And you can turn off the frame here, so you might say frame type, and make it off. And then you can see that
it's just going to be a simple flat thing. So picture can be used for vertical, horizontal or angle views can have a
frame or not. But it doesn't have the option that Edwin was asking about that has to do with rotating to face
the camera. So let me defer that for a later call. Or we'll have that in the section of the course on creating
your own custom parts. So hopefully that was a least a little bit interesting. Let me move on then to John
Stanford. Okay John, | see you're on the call. Let me go and unmute your line to see if you're available. John
are you there? John are you there? OK, maybe John is not actually at the computer right now. He's logged in.
[45:07]

All right so let me see. Let me look at Grace Jeffreys. No Grace - Oh, there is - okay John, interesting. Let me -
so John, it looks like John, you may have connected audio-wise, and then reconnected. John if you called in, if
you dialed in, you'll need to type in your pin number in order for me to be able to unmute you. So if you do
dial in to the call in number, after you dial in then you'll see you can enter in the audio pin, which is usually like
a two digit code, like 25#, and that will allow me to selectively unmute you. Alright let me just see. So Grace
Jeffreys, let me see if you are actually available. So Grace are you there? [46:12]

Grace: Yes I'm here.

Eric: Oh, hi Grace. Okay Grace, you had a question. Let me read it to people. How can | do this without having
a Complex Profile option? Okay. So you have the Start edition. And so what is the work around for Complex
Profiles? So Grace is one of the people in the course who has the Start edition. And not everybody who has
ArchiCAD even knows that there is something called the Start edition. Itis a less expensive version of ArchiCAD
that Graphisoft started promoting more actively maybe three years ago. It is about $2000 instead of $4250,
and it has many, maybe 2/3 or 3/4 of the tools that are in the standard ArchiCAD. But Graphisoft deliberately
leaves out certain components, so that you have to work around them. And if you're a small office, you can live
without it. But they play a double edged game here whereas on one hand, you can get into ArchiCAD and use
it productively for less money; on the other hand, at some point you may go, "Well, | really need the full
version, because it gives me more options." [47:20]

So the answer Grace, in terms of this one, how would you do this in the Start edition. And it's the old
fashioned way that we would do it. It's not as nice, but it does work. I'm going to take the Slab tool. And this
will teach - this certainly will teach another trick that everybody can use for a variety of purposes. So let's just
do this. I'm going to go to the Slab tool. And I'm creating a slab that would be 1 foot thick. It doesn't really
matter too much here. I'm going to do the certain thing that | did here, which is 3x7. So this is now a slab. If |
go to 3D here, and let me go to an axo view, we can see it. You can see that | just created this little slab. And
this you can do of course in the Start edition. Now in 3D or 2D, you can go to the edge of this, and again I'm
going to curve this. [48:17]

So I'll just do a similar shape. And | can do that in 2D or 3D. Right now | don't need to be precise because I'm

just demonstrating. But you may want to precisely make it a certain height. Now this element here, I'm going
to want to look at by itself and turn it into an object. And this is a technique that is definitely useful for anyone
to know about. It'll be used for you Grace, to work around the limitation with Complex Profiles. But for others,

11



Best-Practices-Coaching-Call-March-2-2011

it'll be just how do you create an object. So let me go back to the floor plan and select this. And we'll right click
and say show just the selection in 3D. [48:55]

Now if | do that, you can see that it now isolates this there. So I'm going to go to the View menu, and 3D View
Mode, 3D Projection Settings. And you can use the shortcut Shift+Command+F3 or Shift+CTRL+F3. This allows
me to view it in any orientation, and | can rotate around the camera. It could be like this, this would just sort of
get me around here. But let me show you what | really want to do is not so much rotate camera round as
change my perspective on it. So there are some preset ones in Isometric you can see here, and other standard
ones. The one we want to use is a side view which in architectural drawing terms would be an elevation.
[49:45]

And when | do an elevation, you can see that it's indicating that | am looking from the side, and | can rotate this
camera position around. Now what | want to do is take it up to the top here, where the asimet is 90°, because
the asimet indicates the angle around the circle here on the plan. This would be looking from what would be
nominally called north elevation at the thing. In this case it's not a building but I'll say okay. Looking at the top
of that arch, so you can see that it looks curved there. And having done that, I'm just going to go to the File
menu and turn it into an object. So I'll go to Libraries and Objects, and save 3D model as. [50:30]

What this is saying is that whatever is in the 3D model window, which is only this one arch, I'm going to save it
as a library part. When | do that, I'll just call it "Arched Element". And where am | going to save it? Well if
you're in a version before ArchiCAD 13, say ArchiCAD 10, 11, 12, you would have to say "l would like to save it
in a certain folder". You can browse for the folder here in a similar way. If you're in ArchiCAD 13 or 14 then the
default is to put it into the embedded library, which would be part of the project. Functionally, these were the
same way in terms of the next step. So either way would work. [51:10]

I'll just call it "Arched Element". I'll leave it inside the project, and | want to create an object rather than a
window or door in this case. And when | say Save, and it's done. We didn't see anything happen. I'll go back
on the floor plan. So now what I'll do is go to the Object tool. And you'll notice that in the Object tool its
already loaded in arched element. That was the one | just created. And | can go in and just click the Object
tool and place it. So what you'll notice is that I've got this little rectangle next to it, and if you make a guess,
when | go to 3D and say "Show All in 3D", and you see everything | will see. Then let me go to rotate this
around the Orbit tool, zoom out. Actually just Fit in Window here. And you can see that I've got two of these
elements. One, the original one lying horizontally, the other one vertically. [52:06]

And so obviously now | have the equivalent of that profile and | can use that in any version of ArchiCAD to
create complex shapes. And in fact, when you want to create a door panel, a custom door panel, or a glazing
window configuration, you may create things lying down on the floor and then turning them into objects. And
so I'll be going into variations of this in the section of the course on modeling. But this is one part of it. Now if |
could take this particular one, which is the new object that says "Arched Element", | can go into the settings
and | can for example, right now it's 1 foot thick because it was basically a piece of floor slab that was 1 foot
thick. But | can make it bigger. Let me just make it 5 feet. And we're going to see is sort of like a tunnel there.
[52:57]
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And you'll notice also, if | zoom in on these elements, that the ends are this wood color. I'm going to say it's
probably pine or something like that. And this edge, whether it's thin or thick, is this gray. That is basically
whatever the original element was, the new element is going to be. And you'll see that this says Pine for the -
or if | go to the edge here, you'll see it says Paint. And if | were to make this red, or if | were to make it
whatever, brick or whatever, than this would look different. Then when | turn that into an object, it would also
correspond. So while there are ways to make the object metric, meaning you can change it on the fly and
choose a different material at any given point, this would be the best way if you were doing it for a special
purpose modeling, is to create the slab piece with the correct or the desired materials. [54:09]

And then when you turn it into an object, it would have that. By the way, this can have multiple pieces. So
imagine you had a door panel like this and a doorknob. So you could have both of them together and turn
them into a door panel that had a knob integrated into it. Or, if you were doing glazing for the door, you could
have a cutout in here and then another piece that would be glass. So anything you create lying in this
orientation can then be rotated to become an object. Or using a slightly different variation, a door or a window
or a door panel, or a custom window panel that you use for example in a standard window, but just put in
special glazing. So Grace, does that give you a good idea? [54:56]

Grace: Yes that's great. But how do you use it as a solid object operations and then make it invisible?

Eric: okay, then it would be the same way, you just move it into the proximity of the other element, use the
Solid Element Operations to - what do you call it - make it the operator, and then later have it on a layer that
you turn off.

Grace: Got it.

Eric: The now you have Solid Element Operations available in the Start edition?

Grace: Oh yeah.

Eric: Good. So then as long as you have that, you can use this method instead of using Complex Profiles.

Grace: That's great, | appreciate that. So | would use that if | wanted an extrusion, like foundations or that sort
of thing as well?

Eric: Yes, you certainly can do things for foundations. It would be a little bit harder to make it meet at a corner.
In other words, you know how normal walls, when you join at a corner, thet mitre properly. And a Complex
Profile will also mitre nicely. Whereas this type of extrusion will not clean up at the corners quite right. But
what you could do, in that case, | mean, it would be laborious in terms of if you needed, would be to use
Complex Profile, I'm sorry, Solid Element Operation to cut off the mitre. Essentially, you've taken - you create
other pieces, perhaps just a simple cubes, that would sit at the ends of each element at a 45° angle, and
essentially act like a miter saw to cut off part of it. And then you would hide all of these little cutting pieces. So
that way you would be able to have a complex shape, meeting other complex shape, and have it look clean.
[56:46]
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Grace: Okay, great. Yes.

Eric: Anyway, okay, I'm going to mute you then Grace, thanks for your question. Alright. So | see Steve
Schlueter has a couple of questions. Let me just see, are you on the call Steve still? Yes | see. And let me see if
Steve, let me unmute you. Okay, I've umuted Steve. Are you there? Steve?

Steve: Yes I'm here.

Eric: Okay it was a little noisy, speak up. Where you located Steve?
Steve: [Inaudible]

Eric: I'm sorry where's that?

Steve: In Arizona.

Eric: In Arizona. Okay Steve, you had a question. How do you create a profile molding, window, door or
surround when the opening is curved? Say a Gothic arched opening with an O.G. profile? So you're saying that
we've got not only a something that would be a U shape, looking at an elevation, but actually it is not going
straight into the wall, it's coming like a fan shape or conical cutout? [58:23]

Steve: A typical ogee curve.

Eric: Steve, are you on...you must be on a built in microphone on your computer?
Steve: No I'm not.

Eric: We're getting an echo-like feedback.

Steve: | know that Eric. I'm going to... [Trails off] Say, if you're looking in [inaudible], you would have a
complex profile...

Eric: It's a little hard to hear Steve. You must have moved away from the mic.

Steve: It's hard to hear?

Eric: Just barely. I will...

Steve: I'll tell you what. Sign me off, run with what you can get from what | wrote, and | will follow up.

Eric: Okay. Steve, | apologize. I'd love to be able to help you more directly. One question | have is | have to
admit that I've heard the term ogee profile, but | don't know what that means. This is just an example of the
fact that I'm not an architect, but I've been working with architects, and that's just not one of those things that
I've actually have been taught. So can you explain ogee profile?

Steve: It's an "S" shaped profile.
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Eric: So would this be like a molded piece, sort of like a piece of molding that would follow the curve? |can't
hear you well enough Steve, so I'm going to have to defer this and we're going to have to move on. But
perhaps we could follow up in a later call, and you could perhaps send me an email with an image. | will just
sort of answer the question in general. I'm going to mute you just because the sound is there, so | apologize.
[1:01:04]

In general, ArchiCAD has a lot of built in tools that you can do a lot of complex modeling. But some things are
more difficult to achieve correctly within ArchiCAD. And there are add-ons that will make it possible. There is
one that | recommend for some of the complex shapes that it sounds like you might be [inaudible]. Actually
there are three that relate to an extruded shape that is not going horizontally, and can make a complex
molding. There is one from CADimage that used to be called "3D Profiler" and now they call it "Extrusions" or
something like that. | believe that there is one from [Shi-Graph] which is the Italian Company that makes add-
ons that is called [Archa-forma] or something like that. And there's a very powerful one that | really like called
"Objective", like it is my objective to do this properly, so think about objective. And it's by a company called
Encina, based out of the UK. And what I'll do is I'll make a note to send out that information to people.
[1:02:20]

So those would be tools that would allow you to create more complex shapes that work directly within
ArchiCAD, but of course you do have to buy them. So let me move on. Now | do see that Robin Daffy has a
hand raised. Now | know Robin had sent me a question that | wasn't sure who it was for - the coaching call, but
let me see if Robin if you are actually on the line here. Robin, and are you there? Hello Robin? Okay. So it
looks like Robin may be away from the phone. So let me mute her and possibly come back. [1:03:07]

Okay so Gayla, we have how do you change the scale of the material using the stone fills for flagstone paths.
Okay, that's an interesting question in terms of scale of material. So if we look at the material. Let's just put
this away, go back to floor plan. And we are talking about a flagstone path. So I'm going to do something, I'll
sort of combine things. So, when you're talking about a path, you could be very precise about laying out, or
you could be more diagrammatic. So I'm going to use the tool called the Spline tool to create a patch. So I've
just created one shape and let's create another one here. Let's imagine that that is going to be the general
shape of the path. And in order to turn it into a path, when I need to do is to trace this shape. [1:04:16]

By the way, the nice thing about the spline tool is that when I click on these points, | go adjust them, tweak
them, | can add more points here using this option and therefore adjust it just the way | want, move this
around until | get the shape that looks good. So we don't have to precisely define curves when we're in the
design phase using the Spline tool. Now, what | want to do is use the Slab tool to create a slab that follows this.
Now | can click, click, click, click a bunch of points here, or | could use the Magic Wand. Now the Magic Wand is
not visible in the standard toolbars, but it does come up when we hold down the space bar. [1:04:58]

So if | hold down the space bar - right now all of the sudden my - you can see the magic wand show up, and if |
go - actually, let me do it with the Fill tool just to see. If | do it with the Fill tool, we will see it more visually. If |
press down on the space bar, that is this key that you use between words in a letter or in an email. Not the
Shift key, but the space bar. And I click, you can see that it has filled that. And I'll just undo it. If | go in this
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area, you can see that it filled that area. Now sometimes it will, depending upon where you are, let me just
move outside of here, and do the same thing, it will say "Region Not Found Around This Point". [1:05:41]

So sometimes you'll need, you may not even know that this is legitimate, and you may need to create a couple
of lines here. In this case there is a boundary in terms of the wall, but you may need to create extra lines. But
regardless of whether you're doing it with the Fill tool or another 3D element that's also a polygon, which
would be a closed shape, if | hold down the space bar and get the Magic Wand, when that tool is active | can
create this. Now if | select this, you can see that it's now created a slab, and it has just a moderate number of
points similar to the actual splines. [1:06:22]

If we zoom in very, very tight, we'll see that there actually is a slight difference. I'll zoom even tighter, and you
can see that the highlighted green element, which is the slab, is not quite the same as the original spline. It's
within a certain tolerance factor. This tolerance factor is controlled by the Options menu, Magic Wand Settings.
And it says that when it's trying to match it, how close should it get? And it says is going to be within 2 inches of
deviation. So basically it's creating the slab, as you know, will have straight segments and curved segments that
are pure radiused arcs. And it will create as many as it needs to stay within 2 inches, in this case, of the

ultimate thing. So this particular edge of the green is an arc, whereas the spline, by its nature, has changing
curvature, it is not an arc. [1:07:26]

But it is so close, if | go back to the previous view, it's very hard to tell the difference here in terms of a design
concept. And it's ideal, because you can modify this and end up with something that's constructable, because
you can actually dimension the arcs for construction, but it will look like a smooth series of curves, like the
spline. So that in itself, if we go to 3D here, and Fit in Window, you can see is a shape. Now I'm going to go
ahead and select this shape, and | will go and change the top material from this pine to let's say here's some
sheer. So if you are using a template that comes from the standard ArchiCAD one of any recent year, you'll see
a lot of different cultured stones, sea stones. [1:08:24]

| believe that's also available in the international version, I'm not sure. But if | click this, you can see that if |
pick a sea stone and if | zoom in on this, you can see that it is a stone pattern. Let me pick a different one, let's
say the river rock here. And you'll see that this is going to change. Now, suppose you like this river rock, or you
like the brick, but you want them to be a different size. So they're just bigger or smaller there. If we look at
this material name, here you can see it says "Sea River Rock 02". | can go edit that, or create a duplicate of it
that has a slightly different setting. So in terms of the setting, if | want to edit it, it's going to be under the
Options menu, Element Attributes, Materials. But instead of having to search for it, I'm going to use the
shortcut that may help. [1:09:24]

I'm going to use the eyedropper to pick up the settings of the current element. So right now, with this element
deselected, you can see the slab tool is active, and it's setup to have the top surface be the River Rock. The
reason why I'm doing that is because when | go to the Options menu, Element Attributes, Materials, or in fact,
if | went to Fills or other things, it will bring up the material that refers to this particular object. Actually, |
called it "Paint 02 Whitewash". Here let me just - it must be picking up side material here, which is the Paint 02
Whitewash. So let me just pick up the what was it, river rock. Okay, there. And let me use the eyedropper to
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pick that up. [1:10:17]

Now, the trick that I'm giving you will work. Options, Element Attributes, Materials. When | bring this up, it's
going to bring up the material - nope. Maybe it's the underside here. | apologize. And let's just say we want to
put all of the materials to be the same. So this now - the chain icon made them to be all the same. And now I'll
use the eyedropper to pick up. And let's see if this trick works. Third time may be a charm. Options, Element
Attributes, Materials. There we go, okay. So just the trick is that whatever is the current tool, it will look at,
when you go to materials or fills or other things that are attributes, it will look for the current tool as a clue to
say which one of the many to bring up. [1:11:09]

Now it's not too hard to go find the one you want, but sometimes just by using the eyedropper for a quick
second before you go to the editing area it will just make it quicker, because you'll be able to instantly have the
correct material or fill there for editing.

So moving on to the question that you had, Gayla, about materials. The River Rock here has some information
in terms of what basic color it is and how reflective it is. It also has the hatch pattern here. But the one that's
critical for rendering or presentation purposes is the texture. And the texture you can see is this little picture.
The picture is something that comes from within, in this case, ArchiCAD's library. And it's a texture file. And
while it looks like this is one image, it actually is a sample that's 2x2. If | change this to 1x1, you'll see this is the
actual image that is being repeated over and over again. If | change it to 4x4, you'll see it repeats. And if you
look closely, when you start getting multiple repeats, you'll see the same sort of pattern. [1:12:21]

If you look, it's going up following my cursor, and the next one following my cursor. So the seams do stand out
a little bit to the eye, because this particular material, the square is only a certain size. Now let's look at the
size of the square. When | go to 1x1, it's saying that this is going to be 1 foot 8" square. So that's, in terms of
metric, would be about 0.6 are 0.7 meters. So this particular size is defined here. Now | can modify that, | can
make it a different size. And | can either modify this material, which would affect this material throughout this
project, but not other projects. This only affects the current definition of the material. [1:13:10]

Let me just make this say, 5 feet. Now what's going to happen is that although the picture is the same, now
you'll notice the preview has changed. And now these blocks are much bigger. Of course | can do it more
subtly, but if | just want to make it more dramatic | can say OK. And you'll see now the image has changed to be
much bigger. So, that is the basic idea. We can duplicate materials and use - just get a new material that is
different, or we can modify an existing material which will affect everything in the project with that material.
So Gayla, hopefully that answers your question. Did | - are you there? Did | unmute you? | did not unmute you,
and let me unmute you. | apologize. So Gayla, are you there? [1:14:00]

Gayla: Yes, and it answered my question, thank you.
Eric: Okay. Perfect. Okay, anything else before | move on?

Gayla: No.
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Eric: Okay, so now we're rolling. | have five questions here, and it's already 12:20. Let me see what | can do,
and what is practical. So | see Maura Lester has a question. Would the profile manager be used to create a
wall section showing framing materials? Okay, interesting question. Let me just answer it. Conceptually
Maura, because it would take awhile to demonstrate, and | will cover this in the course section on Complex
Profiles. You can have, in addition to the Complex Profiles that have the molding outside of the wall, you can
have pieces of the wall that are different inside. In other words, you could put a piece of wood inside concrete
or the insulated space, that would be representing framing. And that's simply done by creating a profile - I'm
sorry, a fill, that represents what you would see when you cut through the wall. So here it's wood, and below it
it's insulation or airspace, cavity, etcetera. [1:15:17]

So the simple answer is yes, you can do the Profile Manager. It does get a little more complex, because there's
no way in the profile manager, in its standard, simple usage, to create an “X”; to indicate that the framing is cut
through. So you know how you have a rectangle with an “X” going through it, to indicate a particular type of
section relationship. In order to do that, we do a trick, we basically, if you think about a piece of framing that
has an “X”, if you think instead of of the two lines making the “X”, of the four triangles that are created by the
“X”. We basically need to create a profile with those four triangles. And then the lines that make up the “X”
appear to be there, but it's actually by creating by four pieces of separate little wood-shape pieces. And then
there's another thing you have to do, is actually make them out of different materials, meaning that each fill
has to have a different name. Because otherwise it will merge them together. [16:25]

So that, for some of you, my explanation will light a light bulb and you'll go, “Oh, | get it”. For others, you'll say,
“That's a little bit too fast.” | will explain that in a section of the course down the line. So | hope that at least
gives you a quick idea, since we're running later. And | only have a few more minutes to go. So | see Ted
Mengers asked - “In relationship picture, where do you place your JPGs or TIFs in the Library Manager?” Okay,
this is something that | can quickly address here. So if | look again at the Materials, Options, Element
Attributes, Materials, and we look at that material that | was just working on, and click on the search button,
you'll see that this particular material - and I'll open it up wider, it - where is it? Here itis. Okay. It's “C River
Rock 02”, and obviously there is a long list of these stones, cultured stones which is a folder. That is in Textures,
that is within the Library folder. So in other words, in the standard library, there are some folders here for
LightWorks materials, General Textures, and then in the U.S. there's some additional ones from a licensed
company called Arroway. [1:17:55]

So these are resources that you can pick from, so you can see there's just a whole lot of different types. So not
all, let's say there are many more resources here than are used in active material list. So when you say, “Well,
they don't have the type of corrugated steel,” or “They don't have the type of grass, or the type of landscaping
that | want to use.” You may find that actually does exist in the textures that are already supplied. You just
need to create a new material that uses that texture. Now that being said, let me then answer your question,
Where do these go? Well basically, this is in the Library. And what's critical is that this folder is being loaded as
a library which gives ArchiCAD access all of the sub folders and items within that. [1:18:45]

So if | go to the File menu — actually, let me just cancel out of this. Go to File menu, to the Library and Objects,
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Library Manager, we'll see that this does look quite different I've already explained in an earlier course module,
between ArchiCAD 10, 11, 12, and 13 and 14. So regardless of what Library Manager style you've got, you've
got one or more folders that are linked and loaded in your Library Manager. And by loading this folder, you'll
load everything within it, it will give access to it. It is quite possible to load additional folders, and say that you
might have a folder of textures that you load. You can also load individual components in ArchiCAD 10, 11 and
12, or you can embed them in 13 or 14. [1:19:41]

And so, if you have a picture file that you want to use, you can either add it in as an individual element as in an
embedded library or project library, or you can put into a folder of other things that you're loading in the
Library Manager. You can collect a bunch of textures, either one by one, or by buying or downloading
collections of things, and have that folder loaded as well. So basically by loading that folder, either you can put
it into the standard library, but | don't recommend it. If it's something that you created or purchased, somehow
it's not part of the standard. Simply because the standard library is probably going to be updated one or more
times by Graphisoft during the course of ArchiCAD 14 or whatever version you've got. [1:20:30]

So | recommend if you are creating your own textures, or purchasing or downloading them, you put them into
another folder, and you load that folder in the Library Manager. Here in 14, we'd click on the “Add” button.
And it would say, “Where do you want to load?” And I'll go say, Load, here's the folder called Rugs. And these
actually have, if | look inside it, a bunch of JPEGS. If | say choose that, then you can see that Rugs is a folder
with a bunch of textures. And now, if | say OK, and | go to -having reloaded that, or in a moment after it
reloads, if | go to the Options menu, to the Element Attributes, Materials, and let me just see Ted if you're still
there. [1:21:19]

Let me see if | can unmute you in case you have something there. So Ted, your umuted now. And if | go to
Element Attributes, Materials, we're going to see the - if | do a search, we'll see below the ArchiCAD Library 14
is Rugs. | could actually then pick a rug as a material. Things like that. Now you wouldn't typically use this in a
repeated pattern, but you would use this - in fact, that picture object that | showed you earlier, which was a
framed picture but could be done without the frame, and put horizontally. And you can say I'd like to Put that
picture object on the floor and give it this particular area rugs as the custom picture. So Ted, does that answer
your question?

Ted: That answers that and more, thanks.

Eric: Okay, excellent. Alright, so I'm going to mute you then. And John Stanford, okay so john, I'd given you a
shot earlier, let's see. You're dialed in correctly now. Okay. So let me see if you are there. Okay, | do see that |
can unmute you. So John, are you there? Hey John? Well maybe you are dialed in, but - there you are.

John: Can you hear me now? Okay.
Eric: Yes.

John: I'm having phone problems.
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Eric: Okay, so you had a question of Complex Profiles to create a vertically curved wall. So far | haven't been
able to get windows and doors to fit cleanly into the walls. Is there help with this? So you have a wall that is
vertically curved, you mean it's not going straight up and down, it actually curves as it moves from floor to
ceiling?

John: Right.
Eric: Okay, and when you put in a door or window, it just doesn't work right?

John: Yes what | get, I'm looking at one right now, is that the —it's a window and the sill cantilever is probably
about a foot outside of the face of the wall, and the upper level projects back into the rooms out of the frame 4
or 5 inches.

Eric: So basically, it's sticking out of the wall and it's in the wrong relationship to the wall?
John: Right.

Eric: Right, okay. So that can get into some complex things, but let me see if | can just do a quick explanation of
one part of this. So let me go back to the Design menu to the Complex Profiles, Profile Manager, and let's go to
say the “Brick Wall” here. And let me edit it again. Okay. So what you'll see is here's the shape of the wall that
we've got. And there are a number of dashed lines that you may, if you haven't worked with the Complex
Profiles, you may wonder what they are. I'm going to turn them off, and then explain them very briefly. So I'm
going to turn off these extra lines. [1:24:45]

Now Horizontal Stretch basically says anything within this area, | can change the thickness. So, obviously, if this
is the body of the wall and it's 8 inches thick or something like that, or 0.2 meters, | could then make it thicker.
And when | do that, it will make this part thicker, but the outside, the molding that is sitting outside, it would
not distort. So | could make this twice as thick, but the molding would have the same width. So thatis what a
Horizontal Stretch does. In the same way, when | turn on the Vertical Stretch, it's basically - if | wanted to
make the wall taller, the center part would get longer, but the upper parts and lower parts would float and
would not distort. [1:25:28]

So these are some extra lines here. Now that's not what your issue is, but | did want to mention that those two
lines exist. There's another line here called the “Opening Reference”. And you can see and it comes upin a
reddish color. And this indicates where the window or door gets placed. So in other words, if | wanted to, |
could say this red line was out there, and then that would mean when the window, when it would be put in,
would think that this was the surface of the wall. Obviously that's not what we want, so I'll move it back on
there. And | don't even know, | don't think stretch matters too much if it's vertical. But basically this is it's
orientation for where the window should be placed. [1:26:11]

Now if the wall is curved, and if | go here in and curve it, then what | want to do is take this line and can we
curve this, yes we actually can curve this. However, | probably want to move that point in and curve it back
there. So now, what that does, I've made the red line here. Excuse me, on the face of the wall. And if we put
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in window, let's say we had a little tiny window up in this area, it would understand that this would be the
surface it should orient to for angling possibly, and definitely for the depth in relationship to the wall. This is
something that some people, when they create Complex Profiles, don't understand what this Opening
Reference does. And it definitely will affect whether the window sits in the wall, or possibly sticks out in the
wrong way. Is that something that you were aware of John? [1:27:08]

John: Yes, but | think | did it wrong. | think | was working with the blue line and curving that, and | don't think |
even saw the red.

Eric: Okay, so this is the Opening Reference, and it's referring to how the openings, like doors and windows, will
fit into the wall, what would he consider the face of the wall, for putting in the door or window.

John: Yeah, | think | should probably take care of my issue.

Eric: Great, okay. Well, nice to hear from you John, and I'm going to mute you. And just do maybe one or two
more questions. Is that alright John?

John: That's great, thank you Eric.

Eric: Okay, so let's see, Gayla says | can't see your cursor anymore. Thank you for letting me know. | don't
know why this seems to go away at some point during the presentation. I'm looking now at my secondary
screen, and | can see, you're right, it's not been carried across there. Let me just go to the floor plan does it —
are we seeing this here, I'm not seeing my cursor. Let me just go out of ArchiCAD and then back in. And see if
that - now you're still not seeing my cursor. So that is a mystery, | apologize. | will try to check with
GoToMeeting or Citrix, that makes GoToMeeting to see if they have any idea why the cursor shows okay for a
while and then at a certain point goes away. So thank you for giving me the feedback. [1:28:46]

So Steve Schloeder asked a question. “The Line tool on the MasterTemplate seems to have a default to an
arrow on one end. How does that change so there's no arrow? Okay, that's an easy question. So the Line tool
here, let's just close this in the Profile Manager. So the Line tool, if | draw a line, there it is. Now the Line tool
has some options here in the upper right. | can tell it to have an arrow, then you can see - and I'll just zoom in.
And it has an arrow that's at the starting point. This would be making an arrow at the end point. And this
would be making an arrow at both ends. [1:28:28]

Now you can select any one of these and change it. So for example, | can say, Oh | didn't mean to have an
arrow at both ends, I'll just change it to a straight line. So by selecting it and changing it, | can do that. And
then at any point, | can either go to the Line tool and change it's settings. So right now it says “Double End”.
And | can change just like | did, and then all new new ones would be affected. Or, | can use the eyedropper and
say I'd like to eyedrop this one. And that means now the line will have an arrow at the end. Or | can eyedrop
the one that has nothing there, and then it will just be straight. So Steve, | hope that answers your question.
[1:30:08]

So basically just change the setting, and then your lines will, before you have a line, in other words, the default
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setting. Alright. So Albert also commented about the cursor does not show on my screen. And you couldn't
see the Magic Wand. On that's a pity. Okay, so | will try to track that down. Thank you for the feedback.
Alright, so Maura says, “Thank you, very helpful.” So I'm glad that | was able to answer that question. And
Robert says, “Great Questions. Best 90 minutes of training | have ever had.” Thank you Robert Stensland. |
really appreciate that. So that was the last question | see listed on the screen. Let's see if there's anybody else
who had their hand raised. So Robin did have her hand raised, but no longer does. [1:30:58]

Let me just see if Robin you're actually, oh, you raised your hand. Okay. Let me unmute you. Hey Robin. Are
you there? Hello? Robin? Okay, | don't have - the audio isn't working there, so I'm going to mute you. |
apologize. Okay, so let's see is there anything else? Okay, so Steve Schloeder, thank you for everything.
William Ellinger couldn't see the eyedropper either. Ooh. Okay. So that definitely makes it hard for you to see
what | was referring to. So yes, the cursor obviously changes shape from the arrow to the magic Wand or the
eye dropper, and if you can see it, then of course my training is going to be less clear. But | will check with
GoToMeeting and we'll see if they can work. [1:32:05]

So | want to thank you all for joining me today, I'll finish up. As far as | know this was recorded, and so after |
process it, | will post it. So you, as well as everybody who couldn't attend it will be able to review it. And just
another reminder, or just for those people who maybe missed it at the beginning. | apologize for not delivering
more weeks of material in the last few weeks, I've been tied up with this relaunch, global launch of the Best
Practices Course. The good news is that it's coming to a climax tomorrow, I'll be opening the registration for
the course for seven days, and then trying to get as many people excited and interested in signing up. And
then I'll be able to focus again on developing content, and there will be more material delivered to you than |
originally promised. In other words, I'm going to be adding in a module for Quick Start. Ways to use the basics
of ArchiCAD better, that | wasn't originally going to include. And then we're likely to do also an Office Hours
extra coaching session each month. That will allow you to ask more questions and get more help. [1:33:24]

So again, if you do have colleagues who you know would benefit from the course, now is the time to share it
with them. Just tell them that the course is a good thing, and that they should check it out, because as of
tomorrow, I'll open registration for seven days and then | will close it up again for an extended period. | want
to be able to focus on training all of you, and hopefully they'll be a big batch of people who will join in, and |
won't have to worry about marketing it for awhile, I'll just focus on creating some great stuff. So please tell
your friends to visit ABCbestpractices.com. [1:34:05]

Francisco Troncoso thanks me from Patagonia. So let me just see if | can unmute you. | enjoy the fact that
we're reaching people all over the world. So Francisco, are you there? Hello? Hello? Francisco? Hello
Francisco? | can hear just a tiny bit of sound, but not enough. I'll give you one more try. Okay. Maybe you
don't have a microphone there, and you're just listening. So I'm going to mute you again. Anyway, so we've
had people from Australia and Patagonia and of course many locations in North America. Thank you all, I'll
finish up for now and get this recording posted as soon as | can. Do tell your friends, and stay tuned or come
back for the next session which will be at the beginning of April. It's possible | may do that first Office Hours
extended coaching session in March, just going to have to see how the schedule works. I'll certainly start it by
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April. And | will give you that extra coaching. So thanks again, and have a good day or a good evening,
wherever you are.
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